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I.	 Revision History

Version Revision Date

1.0 2015.12

1.1 2016.08

1.2 2017.05

1.3 2018.08

1.4 2019.10

This NovoSampler® Pro Operator’s Guide and the corresponding intellectual prop-
erty rights belong to ACEA Biosciences, Inc. This manual may not be reproduced, 
transmitted, transcribed, translated, or stored in a retrieval system in any form 
without the written consent of ACEA Biosciences, Inc.

Information contained in this manual is subject to change without notification. 
While this manual has been carefully produced to ensure accuracy, ACEA Biosci-
ences, Inc. assumes no responsibility for errors or omissions, or for any damages 
resulting from the use of this information.

The NovoExpress® Software provides users with the ability to control data col-
lection and analysis on the NovoCyte® Flow Cytometer, NovoCyte QuanteonTM 
Flow Cytometer, NovoCyte AdvanteonTM Flow Cytometer with NovoSampler®, No-
voSampler® Pro and NovoSampler® Q. The software contains features to control 
sample acquisition, data analysis, report generation, and quality control testing. 
The NovoExpress® Software is the property of ACEA Biosciences, Inc. Purchase 
of the software grants the user a non-exclusive personal license. The NovoEx-
press® Software cannot be copied or modified in any way without the written 
consent of ACEA Biosciences, Inc.

II.	 Contact Information

Manufacturer ACEA Biosciences, Inc.
6779 Mesa Ridge Road, Suite 100
San Diego, CA 92121
USA

China Distributor ACEA Biosciences (Hangzhou) Co., Ltd. 
Building 4, No.208 Zhenzhong Road,Xihu District,
Hangzhou, Zhejiang Province, P. R. China
310030
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International Distributors Please contact ACEA Biosciences, Inc., or visit 
www.aceabio.com for a complete list of interna-
tional distributors

III.	 Trademark
ACEA Biosciences, the ACEA logo, NovoCyte®, NovoExpress®, NovoSampler®, No-
voFlow®, NovoRinse®, and NovoClean®, are trademarks of ACEA Biosciences, Inc., 
in the United States and some other countries.

All other company and product names might be trademarks of the respective 
companies with which they are associated.

IV.	 Intended Use
The NovoSampler Pro is an optional sample handling module to the NovoCyte 
system. The NovoSampler Pro is used with the NovoCyte Flow Cytometer to 
achieve automatic collection of sample in compatible sample plates or tubes.

V.	 Using this Guide
This manual describes the operation and maintenance of NovoSampler Pro. The 
features of the NovoSampler Pro are controlled through the NovoExpress Soft-
ware. The use of the software to control the NovoSampler Pro will be described 
in this guide.

This manual contains the following chapters:

►► �Overview and Installation: Introduction to the NovoSampler P                  ro. 

►► �Software Overview: Description of the NovoExpress software interface and 
functions related to the NovoSampler Pro. 

►► �Sample Acquisition: Description of performing the instrument QC test, setting 
up work list, performing automatic sample acquisition, and analyzing data. 

►► �Maintenance: Description of the maintenance on the NovoSampler Pro. 

►► �Troubleshooting: Description of errors, possible causes, and solutions.

The appendix lists the supplies and accessories of NovoSampler Pro.

VI.	 Conventions

Text and Keyboard Conventions

The following conventions are used in this guide:
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Format Description

Sequence of numbers 
1  2  ......

Sequences of numbers are used to describe the se-
quence of steps to be carried out.

Italic Font, gold This font is used to refer to another section in the manual 
with additional information.

Italics Font This font is used to describe an operation of the software 
using a button, icon, or function. Tips and additional in-
formation are also in this font.

→ The arrow indicates selection steps. For example, click 
File → Print, means to select the Print function from the 
File menu.

Ctrl+X When using a keyboard shortcut, + means to press the 
two keys simultaneously. For example, Ctrl+C means to 
hold down the Ctrl key (Control) and press the C key.

Symbols

The following table lists the symbols used in this guide:

Symbol Meaning Description
Biohazard This flag indicates that the operation may have po-

tential for biological infection. Protective measures 
should be taken. 

Warning This flag indicates improper or unsafe operation 
could result in material damage, data loss, mild or 
severe personal injury, or even death. 

Shock Hazard This flag indicates that the operation has a risk of 
electric shock. 

Important Important information. 

Additional Informa-
tion 

Provides additional information about the current 
topic or product. 

►►► Form Next to continue this form.

■ The End of the 
Table

This is the end of the table.

VII.	 Safety and Limitations
The NovoCyte System is intended for use by trained laboratory professionals. The 
NovoSampler Pro is designed with measures to protect the safety of the opera-
tor. However please use the instrument in strict accordance with the manual for 
operation, maintenance, and repair. Failure to follow instructions in the manual 
can result in failure or damage to the instrument’s safety features. 

Electrical Safety

 �To prevent electrical shock and instrument damage, follow the following 
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electrical safety guidelines.

►► �Unless otherwise specified, always turn off the flow cytometer using the pow-
er switch and unplug the power cord before performing maintenance on the 
NovoSampler Pro.

►► �Use the proper power supply, and promptly replace any damaged electrical 
wires, plugs, or cables.

►► �If liquid enters inside the system or the system leaks, turn off the power im-
mediately and contact the customer service department of ACEA Bioscienc-
es, Inc.

Biosafety

 �All biological samples and materials that come into contact with the in-
strument or components of the instrument can potentially transmit infec-
tious diseases. To avoid exposure to biohazardous materials, follow the 
following biosafety guidelines.

►► �Take reasonable precautions in handling waste in accordance with the rel-
evant local standards. Avoid having waste come into contact with the mouth 
or eyes.

►► �Do not directly touch the samples or waste. Wear appropriate protective 
equipment including gloves, clothing, and eyewear. Never pipette by mouth. If 
the sample accidentally comes in contact with skin, follow working standards 
and immediately consult a health professional.

►► �Users must wear gloves when handling samples as biohazardous material 
may come into contact with the outside of the sample tube.

►► �Users must wear gloves when handling the orbital shaker or rack as biohaz-
ardous material may remain on the surface.

General Safety

 �While the system is running, do not touch the sample injection probe. Do not 
put your fingers or hands near the opening of the housing of the sample injec-
tion probe.

 �To prevent accidents and ensure high quality data, do not move the instru-
ment after the installation of the NovoSampler Pro by an ACEA professional. If 
the instrument needs to be moved after the installation, please contact ACEA 
for re-installation. The instrument will be re-installed and verified for normal 
operation. 

 �The sample injection probe is a moving part and may cause injury. To prevent 
accidents, do not reach into the NovoSampler Pro while the instrument is run-
ning. When placing or removing samples, do not place your hand below the 
sample injection probe.
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 �The NovoSampler Pro contains moving parts which may cause injury. To prevent accidents, 
ensure that the cover to the NovoSampler Pro is closed during sample acquisition. The No-
voSampler Pro contains a detector to sense if the lid is open to ensure the user’s safety, but 
the user should confirm that the NovoSampler Pro has completely stopped running before 
opening the cover.

VIII.	 Technical Support
If there are operating or technical questions, please refer to the sections relating to the instru-
ment operation in this guide. If a problem occurs, refer to the troubleshooting section in this 
guide for solutions. For additional technical support, please contact your local ACEA Biosci-
ences representative or distributor. When contacting ACEA Biosciences, be sure to provide the 
following information:

►► �The product name, product model and serial number

►► �Usage history of the instrument

►► �Instrument status information on the status bar from the NovoExpress software. If there 
is a warning or error message, please also provide that information.

►► �Experiment information conducted on the instrument, if not confidential.

►► �Details of recent instrument QC test.

For support within the US, please call 866-308-2232. 

For support within China, please call 400-600-1063.

For users in other countries or regions, contact your local ACEA Biosciences representatives 
or distributors, which may be found at www.aceabio.com.

 �When encountering an issue during operation of NovoCyte flow cytometer, NovoSampler 
or NovoSampler Pro instrument, it is highly recommended to submit a Technical Support 
Request by clicking Home → Technical Support Request in the NovoExpress main window. 
The Technical Support Request Creation Wizard automatically collects NovoCyte configu-
rations, NovoExpress system logs, current screenshot, current experiment file and other 
information that helps in the diagnosis and troubleshooting of NovoCyte instrument. User 
can also attach any other files using this function. Please refer to the NovoExpress® Soft-
ware Guide for detailed information on this function.
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1.	 Introduction

NovoSampler Pro is an optional accessory to the NovoCyte system (Figure 1-1). 
The NovoSampler Pro is used with the NovoCyte Flow Cytometer to achieve au-
tomatic collection of sample in compatible sample plates or tubes. NovoSampler 
Pro uses an integrated orbital shaker to achieve efficient mixing of the sample in 
each well and achieve high uniformity across the entire multi-well plate for volu-
metric absolute counting.

Figure 1-1 NovoCyte and NovoSampler Pro System Configuration

This chapter will describe the hardware and installation of the NovoSampler Pro.

1.1	 Hardware Overview

The NovoSampler Pro has a built-in orbital shaker to hold the multi-well plate and 
mix the sample, a cover, and status indication LED, as shown in Figure 1-2.

 
Figure 1-2 NovoSampler Pro

 �The NovoSampler Pro contains moving parts which may cause injury. To pre-
vent accidents, ensure that the cover to the NovoSampler Pro is closed during 
sample acquisition. The cover should only be opened when loading samples 
or when required for maintenance. If the cover is opened during sample ac-
quisition, the NovoSampler Pro will stop running and an error message will 
appear on the NovoExpress Software.

The orbital shaker in NovoSampler Pro is shown in Figure 1-3. The shaker is able 
to hold compatible multi-well plates and the NovoSampler 24 tube rack.
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Figure1-3 Orbital Shaker in NovoSampler Pro

 �Before loading multi-well plates and NovoSampler 24 tube rack, identify the 
correct orientation for loading into the orbital shaker. Make sure the sample 
plate is positioned properly on the orbital shaker and the clips hold the sample 
plate tightly. The sample plate should be inserted down to completely contact 
the surface of the orbital shaker without any tilting. Incorrect placement may 
cause misalignment between the sample wells and sample injection probe, 
resulting in sampling from incorrect wells or damage to the sample injection 
probe or the orbital shaker.

 �The inner surface of the NovoSampler Pro may come in contact with residual 
biohazardous material. When working with NovoSampler Pro, use appropriate 
protective equipment, including gloves, clothing, and eyewear.

NovoSampler 24 tube rack compatible with 12 × 75 mm tubes is included with  
NovoSampler Pro.

 �Only NovoSampler 24 tube rack could be used with the NovoSampler Pro. 
Use the other type of tube rack may cause NovoSampler Pro malfunction and 
damage the instrument.

The NovoSampler Pro status indication LED indicates the status of the NovoSam-
pler Pro. The color of the status indication LED and the corresponding NovoSam-
pler Pro status are listed in Table 1-1.

LED Color Status of the NovoSampler Pro 

Green Normal.

Orange NovoSampler Pro warning. Click the status bar in the NovoExpress 
Software to review the warning.

Red NovoSampler Pro error. Click on the status bar in the NovoExpress Soft-
ware to review the error.

■
Table 1-1 The Status Indication LED Color and Corresponding NovoSampler Pro Status

 �For additional information regarding warnings and errors, refer to Section 5 
Troubleshooting in NovoCyte® Flow Cytometer Operator’s Guide.
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Compatibility

The NovoSampler Pro is compatible with the following plates and tubes:

►► 12 × 75 mm tubes with NovoSampler 24 tube rack

►► 96-well plates (V-bottom)

►► 96-well plates (U-bottom)

►► 96-well plates (flat-bottom)

►► 48-well plates

►► 24-well plates

The minimum sample volume requirement for each plate and tube type is listed 
in Table 1-2.

Sample Plate Type Minimum Sample Volume Dead Volume 

12 × 75 mm tube with No-
voSampler 24 tube rack 90 µL < 50 µL

96-well plates (V-bottom) 90 µL < 50 µL

96-well plates (U-bottom) 90 µL < 50 µL

96-well plates (flat-bottom) 90 µL < 50 µL

48-well plates 210 µL < 170 µL

24-well plates 310 µL < 270 µL

■
Table 1-2 The Minimum Sample Volume Requirement for Each Plate and Tube Type

Throughput

Table 1-3 summarizes the working conditions and the throughput for NovoSam-
pler Pro.

Working Condition Standard Mode High-Throughput

Sample flow rate (µL / min) 66 120

Sampling volume (µL) 10 10

Mix (cycles) 1 1

Rinse (cycles) 1 0

Mixing Speed (rpm)

24-well plate: 2500 24-well plate: 2500

48-well plate: 1500 48-well plate: 1500

96-well plate: 1500 96-well plate: 1500

NovoSampler 24 tube 
rack: 1500

NovoSampler 24 tube 
rack: 1500

Mixing Duration (s) 10 10

Acceleration (s) 0 0

►►►
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Working Condition Standard Mode High-Throughput

Throughput (min) 

96-well plate : < 75 96-well plate : < 45

48-well plate: < 40 48-well plate: < 24

24-well plate: < 20 24-well plate: < 12

NovoSampler 24 tube 
rack: < 20

NovoSampler 24 tube 
rack: < 12

■
Table 1-3 Throughput of NovoSampler Pro

Sample Mixing

NovoSampler Pro has a mixing function to help keep the sample in suspension. 
This function achieves effective mixing with all compatible plates. Users can set 
the appropriate mixing conditions for their specific sample, as the tendency of 
sample to settle depends on the characteristics of the sample (sample density, 
liquid viscosity, etc.).

 �For setting the mixing conditions, see Section 3.2 Experiment Setup in this 
guid for more information.

Carryover

NovoSampler Pro can automatically rinse the sample injection probe and fluidic 
tubing to reduce cross-contamination between samples. When this function is 
used, the NovoSampler has a carryover rate of less than 0.1%.

 �For setting sampling conditions, see Section 3.2 Experiment Setup in this guid 
for more information.

1.2	 Installation

This section describes the process of installing the NovoSampler Pro.

 �Before installing the NovoSampler Pro, NovoCyte instrument must be turned 
off.

 �Before installing the NovoSampler Pro, the tube holder for manual sample 
acquisition must be removed.

1 To remove the tube holder, loosen the screws as shown in Figure 1-4 and take the 
tube holder off from NovoCyte.

Figure 1-4 Remove the Tube Holder

►►►
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2 Position the NovoSampler Pro to NovoCyte instrument as shown in Figure 1-5. Align 
the left and back side of the sampler with the NovoCyte and gently push the sampler 
against the NovoCyte. Make sure the NovoSampler Pro is closely in contact with the 
NovoCyte. Make sure there is no gap between the NovoSampler Pro and NovoCyte 
on both left and back sides.

Figure 1-5 Properly Positioning the NovoSampler Pro

 �Ensure that the NovoSampler Pro is in close contact with NovoCyte Flow 
Cytometer on the left and back sides during installation is very important 
for the proper operation of the NovoSampler Pro. Failure to do so would 
cause calibration failure or the collision of the sample injection probe to 
the sample plate.

3 Open the cover, find two screw holes. Align the two holes of the NovoSampler Pro to 
the two holes on the NovoCyte instrument (Figure 1-6). Tighten the screws (Figure 
1-7) to install the NovoSampler Pro.

Figure 1-6 Align the Two Holes of the NovoSampler Pro

►►►
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Figure 1-7 Tighten the Screws

 �Use appropriate force (i.e., finger tight) when tightening the screws. Ex-
cessive force may result in damage. Ensure that the connections are 
tight and that the sampler is stable during sample acquisition.

4 Connect the cable between the NovoSampler Pro and the NovoCyte Flow Cytometer 
as shown in Figure 1-8.

Figure 1-8 NovoSampler Pro and NovoCyte Flow Cytometer Cable Connection

►►►
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5 Power on the NovoCyte Flow Cytometer by pressing the power button  on the 
instrument. Start the NovoExpress Software by double-clicking the icon  from the 
workstation desktop. The software will display a dialog box requesting to calibrate 
the NovoSampler Pro, as shown in Figure 1-9. Click Calibrate to start the calibration 
of the NovoSampler Pro. Calibration can be postponed, but the software will not 
allow for samples to be collected until a calibration is performed successfully. To 
manually start the NovoSampler Pro calibration, click the Instrument → NovoSam-
pler Pro → Calibrate on the NovoExpress software.

Figure 1-9 Dialog Box to Indicate NovoSampler Pro Calibration

 �If the NovoCyte is already powered on, ensure NovoExpress is launched, 
click Instrument → NovoSampler® Pro → Power Up in NovoExpress soft-
ware main window to power on the NovoSampler Pro (Figure 1-10). The 
software will prompt a dialog box requesting to restart the NovoExpress 
software, as shown in Figure 1-11. Click Yes to restart the software. After 
log in the software, software will prompt to calibrate the NovoSampler 
Pro as shown in Figure 1-9. User can click Calibrate to calibrate the No-
voSampler Pro.

Figure 1-10 Power on NovoSampler Pro 

Figure 1-11 Dialog Box to Restart NovoExpress Software

 �For additional information on starting up the NovoCyte Flow Cytometer, 
refer to the Section 2.1 Instrument Start-up in NovoCyte® Flow Cytometer 
Operator’s Guide.

 �Before calibrating the NovoSampler Pro remove any plates in the orbital 
shaker. Plates or other items in the orbital shaker may result in a colli-
sion and damage to the instrument.

■
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2.	 Software Overview

The NovoExpress Software controls the functions of NovoSampler Pro, including 
calibration, reset, sample mixing, and sample acquisition. The NovoExpress Soft-
ware will automatically detect if the NovoSampler Pro is installed and connected 
to NovoCyte instrument.

2.1	 Software User Interface

The software interface when NovoSampler Pro is connected is shown in Figure 
2-1.  Compared to the software interface with NovoCyte alone, differences are 
observed in the Menu Bar, Cytometer Control panel, Experiment Manager panel, 
and Work List. The Plate Manager panel is only visible when NovoSampler Pro is 
installed.

Figure 2-1 NovoExpress Software Interface with NovoSampler Pro Installed

When analyzing NovoCyte data offline on a computer not connected to a No-
voCyte Flow Cytometer, the NovoExpress software can be set to NovoSampler 
Pro not installed. To view the NovoSampler Pro related software interface and 
functions in the offline mode, open the instrument configuration window by 
clicking Instrument → Instrument → Configuration to change the setting (Figure 
2-2). Check the NovoSampler installed checkbox, choose NovoSampler Pro in the 
prompted dialog box (Figure 2-3), and click OK. The software will prompt a dialog 
box, asking to restart software. After restarting, the Cytometer Control panel, the 
Experiment Manager panel and the Work List are all updated, and the Plate Man-
ager panel will be visible.
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Figure 2-2 The Instrument Configuration in NovoExpress Software Offline Mode

Figure 2-3 Dialog Box to Choose NovoSampler Pro or NovoSampler  
in NovoExpress Software Offline Mode

2.2	 Menu Bar

In the Instrument tab, the functions of the NovoSampler Pro are available when 
the NovoSampler Pro is connected. These functions include Mix, Reset, Calibrate/
Stop Calibration, Power Down/Power Up, and Manage Plate Types. The Menu Bar 
is shown in Figure 2-4.

Figure 2-4 The Instrument Tab of Menu Bar

Mix

To use the Mix function, click the Mix button from Instrument → NovoSampler Pro 
→ Mix. This function will immediately begin to mix the sample. The Mix button 
from the Cytometer Control panel has the same function.

Reset

To use the Reset function, click the Reset button from Instrument → NovoSampler 
Pro → Reset. The reset function will move the orbital shaker to the home position. 
This will allow a reset of the NovoSampler Pro in case of misalignment or error.
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Calibrate

To use the Calibrate function, click the Calibrate button from Instrument → No-
voSampler  Pro → Calibrate. This function automatically aligns the NovoSampler 
Pro with the NovoCyte Flow Cytometer.

Stop Calibration

Once calibration is initiated, the Calibrate button in the Instrument → NovoSam-
pler Pro menu will automatically become Stop Calibration button. Click Stop Cali-
bration will stop the NovoSampler Pro calibration.

Power Up

When clicked (and the NovoSampler Pro is properly installed), the NovoCyte will 
power on and allow the operation of the NovoSampler Pro. After execution, the 
status indication LED on NovoSampler Pro will light up in green color. The Novo-
Express will prompt a message to restart the software. After the software restart, 
a dialogue box requesting to calibrate the NovoSampler Pro will be shown. Click 
Calibrate to start the automatic NovoSampler Pro calibration procedure. The soft-
ware features for control and use of the NovoSampler Pro will be available after 
restart of the NovoExpress software. 

 �This feature is only visible when logged into NovoExpress Software with the 
account with Power Down/Up NovoSampler privilege.

Power Down

When clicked (and the NovoSampler Pro is properly installed), the NovoCyte will 
power off the NovoSampler Pro. After execution, the status indication LED on 
NovoSampler Pro will be off. The NovoExpress will prompt a message to restart 
the software. After the software restart, only the NovoCyte stand-alone features 
will be available. 

 �This feature is only visible when logged into NovoExpress Software with the 
account with Power Down/Up NovoSampler privilege.

 �NovoSampler Pro should only be uninstalled when powered off. Uninstalling 
the NovoSampler Pro when it is still powered up may cause damage of the 
NovoSamplerPro.

Manage Plate Types

User can add, remove, calibrate, and modify plate settings in the Manage Plate 
Types window. To use this function, click the Manage Plate Types button from 
Instrument → NovoSampler Pro → Manage Plate Types. The Manage Plate Types 
dialog is shown in Figure 2-5.

Figure 2-5 The Manage Plate Types Dialog Box
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 �A new plate type must be calibrated before it could be used on NovoSampler 
Pro. Once calibrated, the same type of plate can be used for an experiment 
without any calibration needed. 

 �Plate Type is defined by the format of the plate (24/48/96-well plate or 24 tube 
rack) and the geometry of the well. For example, two U-bottom 96-well plates 
are considered as different types if they have different height of the well.

 �Specify the plate name to be calibrated in details to help easy recognition of 
different plate type, such as NuncTM 96-Well Polypropylene Plates, Corning® 
Carbo-BINDTM 96-well plates, etc.

All the default plate types are listed in the left box in the Manage Plate Types 
window. NovoExpress software has six built-in plate types including 96-well plate 
(U-bottom), 96- well plate (flat bottom), 96-well plate (V-bottom), 24-well plate, 24 
tube rack and 48-well plate.

►► �Name: The name of the selected plate type. Edit it to rename the customer 
plate other than the built-in plate types. The name of the built-in plate type 
cannot be changed.

►► �Plate Format: The plate format of the selected plate type. Supporting format 
includes “96-well plate”, “48-well plate”, “24-well plate”, “24 tube rack”. This 
property cannot be changed.

►► �Max Volume: Set the limit for the maximum sampling volume user can input 
in the Stop Condition of Cytometer Setting panel for an experiment. Max Vol-
ume can be set in a range between 10 µL to 5000 µL.

 �Input an appropriate Max Volume to avoid running out of sample for a well 
during an experiment.

►► �SIP Movement Offset (+ Down, - Up): The sample injection probe height offset 
relative to the default height when aspirating the sample from each well or 
tube. Positive value means the height is decreased. Negative value means 
the height is increased. The SIP Movement Offset can be set in a range be-
tween -10 mm to 5 mm.

 �Set SIP Movement Offset to be Positive can help to reduce the dead volume 
from each well. 

 �Be cautious to set the SIP Movement Offset. Incorrect setting would result 
in collision of SIP to the bottom of the well. During plate type calibration, No-
voSampler Pro automatically calibrates the default SIP height. Normally, there 
is no need to adjust the SIP Movement Offset.

►► �Mix Speed: The mix speed of the orbital shaker. The Mix Speed for 96, 48 and 
24-well plate can be set in a range between 60 rpm to 3000 rpm. The Mix 
Speed for 24 tube rack can be set in a range between 60 rpm to 1800 rpm.

►► �Mix Acceleration: The acceleration time for the orbital shaker to reach the 
specified Mix Speed. Mix Acceleration can be set from 0 second to 10 sec-
onds.

►► �Mix Duration: The mixing time for the orbital shaker to mix the sample. Mix 
Duration can be set from 1 second to 120 seconds.

►► �Built-in: Checked if the selected plate is the built-in plate type. Built-in plate 
types cannot be renamed or deleted. The built-in information is read only.

►► �Calibrated: Indicate if the selected plate type is calibrated. Only calibrated 
plate type can be used in experiments.
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►► �Reset to Default: Click this button to reset the Max Volume and SIP Movement 
Offset of the selected plate type to default. Only built-in plate types can be 
reset to default.

The built-in plate type has been tested with biological samples, including human 
peripheral blood sample and cultured cell lines, to determine the default mixing 
settings. At the default mixing settings, the biological samples can be effectively 
mixed and uniformly suspended inside each well. The table below lists the de-
fault mixing settings and the maximum values allowed to be used for six built-in 
plate types.

 �Determine the proper mixing speed and volume before running the experiment 
can help to avoid any potential spills during the experiment running.

 �When NovoSampler Pro is selected to work in Standard and High-Throughput 
mode, the software will automatically apply the default settings for mixing 
cycle, rinse cycle, mixing speed, acceleration, mixing duration, sampling vol-
ume and flow rate.

Plate Type

Default Value Max. Value

Mix 
Speed
(rpm)

Mix  
Duration

(s)

Accel-
eration

(s)

SIP 
Offset
(mm)

Mix  
Duration

(s)

Accel-
eration

(s)

Mix  
Speed
(rpm)

Max  
Volume

(µL)

24 tube rack 1500 10 0 0

120 10

1800 5000

96-well plate
(V-bottom) 1500 10 0 0 3000 100

96-well plate
(U-bottom) 1500 10 0 0 3000 200

96-well plate
(flat-bottom) 1500 10 0 0 3000 200

48-well plate 1500 10 0 0 3000 1000

24-well plate 2500 10 0 0 3000 2000

■
Table 2-1 Default and Maximum Allowed Mixing Settings for the Built-in  

Plate Types of NovoSampler Pro

►► ��Remove: Click this button to delete the selected plate type. Only non-built-in 
plate types can be removed.

►► �Add: Click this button to add a customer plate type. Input plate type name 
for new plate type in the prompted window. The Copy From function helps to 
quickly set up a customer plate type based on the format of an existing plate 
type. Choose a proper existing plate type from the Copy From drop-down list. 
The Plate Format, Max Volume, SIP Movement Offset, Mix Speed, Mix Accel-
eration and Mix Duration settings are copied from the Copy From plate type.

Figure 2-6 The Add Plate Type Dialog



22

22
Software Overview
Cytometer Control Panel

►► �Calibrate: Click this button to calibrate the selected plate type. Only calibrated 
plate type can be used in experiments. The Calibrated checkbox indicates if 
the selected plate type is already calibrated. Figure 2-7 shows the dialog box 
prompted when the Calibrate button is clicked.

Figure 2-7 Dialog Box Prompted when Clicking Calibrate Button

Click OK after properly placing a plate of the selected plate type on the orbital 
shaker of the NovoSampler Pro. It will take several minutes to complete the plate 
type calibration process. If the plate is not placed properly, the calibration could 
fail and a dialog box shown in Figure 2-8 will be prompted. Reposition the plate 
properly and conduct the calibration again.

Figure 2-8 Dialog Box Prompted when the Plate Type Calibration Fails

 �Before loading multi-well plates and NovoSampler 24 tube rack, identify the 
correct orientation to position the plate or the tube rack onto the orbital shak-
er. Make sure the sample plate is positioned properly on the orbital shaker and 
the clips hold the sample plate tightly. The sample plate should be inserted 
down to completely contact the surface of the orbital shaker without any tilt-
ing. Incorrect placement may cause misalignment between the sample wells 
and sample injection probe, resulting in damage to the sample injection probe 
or the orbital shaker.

 �Before calibrating the NovoSampler 24 tube rack, ensure a 12 X 75 mm tube 
is fully inserted in each position of the tube rack.

 �Once plate type calibration is initiated, the Calibrate button in the Manage 
Plate Types window will automatically become Stop Calibration button. Click 
Stop Calibration will stop the plate type calibration. 

2.3	 Cytometer Control Panel

Figure 2-9 shows the Cytometer Control panel when NovoSampler Pro is con-
nected. The Active Sample Information area contains the sample name and the 
sample well ID. In the Experiment Control area, there are two options to start the 
sample acquisition, including Run Single Well and Run Plate. Click Run Single Well 
to run a single well in the plate. Click Run Plate to run multiple wells.
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Figure 2-9 Cytometer Control Panel

 �When Run Single Well is selected, the NovoSampler Pro does not perform the 
mixing function before sample acquisition. To mix the sample, click the Mix 
Sample button in the Cytometer Control panel.

 �When Run Single Well is selected, NovoSampler Pro will automatically rinse 
the sample injection probe after sample acquisition. This SIP rinse function 
will minimize the carryover between samples.

 �Before acquiring a sample, ensure the sample is the Active Sample and the 
Well ID is correct. In the Experiment Manager panel, double-click a sample 
node to set the sample to be the Active Sample. The active sample will be 
indicated by a red arrow on the left of the sample in the Experiment Manager 
panel.

 �For additional information regarding the Run Single Well function, see Section 
3.4 Single Sample Acquisition in this guide. For additional information regard-
ing the Run Plate function, see Section 3.6 Automatic Sample Acquisition in 
this guide.

NovoExpress can automatically shut down NovoCyte after plate run is complet-
ed. Check the Shut down NovoCyte after plate run checkbox in Cytometer Control 
panel to activate the automatically shut down function. When the plate run is 
completed, NovoExpress will prompt a 60 seconds count down dialog box to 
confirm whether or not to shut down the NovoCyte. The dialog box is shown in 
Figure 2-10. If no action taken after 60 seconds, NovoExpress will shut down the 
NovoCyte automatically.

Figure 2-10 Dialog Box to Confirm whether or not to Shut down the NovoCyte

 �Automatic shutdown function is only effective for Run Plate. Run Single Well 
will not trigger the shut down process.

2.4	 Experiment Manager Panel

Figure 2-11 shows the Experiment Manager panel when the NovoSampler Pro is 
connected. The samples listed in the Experiment Manager panel include the Well 
ID and the sample name, separated by a colon. Click the sample node to select 
the sample, right-click and select Rename to rename the sample. When renaming 
the sample, both the Well ID and the sample name can be modified. Specimen is 
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also associated with a Specimen ID. The Specimen ID is the number before the 
specimen name, separated by a colon. The Specimen ID is used to identify speci-
men and can be modified. For additional information regarding the Specimen ID, 
see Section 2.5 Plate Manager Panel in this guide.

Figure 2-11 Experiment Manager Panel

 �For additional information regarding the Experiment Manager panel, refer to 
the Section 6 Experiment Manager in NovoExpress® Software Guide. 

2.5	 Plate Manager Panel

The Plate Manager panel (Figure 2-12) will only be available when the NovoSam-
pler Pro is installed or the NovoSampler installed checkbox is checked in the In-
strument Configuration window in the NovoExpress software offline mode. This 
management tool provides users with an intuitive and convenient way to manage 
samples on a multi-well plate or on NovoSampler 24 tube rack. The Plate Man-
ager also allows user to set up the working mode, plate type, mixing and rinsing 
conditions.

Figure 2-12 Plate Manager Panel
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Table below provides details on all functions of the Plate Manager panel:

Icon Description 

The Plate Manager panel displays an 8 x 12 grid indicat-
ing a 96-well plate map. In settings for a 24 tube-rack or 
a plate type other than a 96-well plate, invalid wells will 
be grayed out.
In one plate, multiple samples can be set with the same 
Well ID. In the grid, one well will show one sample at one 
time. The currently visible sample in a well is defined as 
selected sample of a well.
The state of each well can be:

►► �  This icon indicates that this well is selected. 
Multiple wells can be selected at the same time.

►► �  The number is the Specimen ID and indicates to 
which specimen the selected sample belongs to.

►► �  An underlined number indicates that the se-
lected sample has acquired data.

►► �  The arrow in the upper right corner indicates 
that the well has multiple samples. Context menu of 
the well will list all samples. 

►►  The italicized number indicates the acquisition 
sequence of the selected sample.

►► �  A red background indicates the well contains 
the Active Sample. 

►►  A green background indicates that the well 
contains sample in queue to be collected.

►► �  /  An alternating green and dark green 
background indicates that the well contains sample 
currently in acquisition.

►► �  /  An alternating green and red background 
indicates that the well contains sample currently in 
acquisition and also is the Active Sample.

The following operations can be operated on the plate 
grid:

►► �Click:  Click the header of a row or a column to 
select the entire row or column. Click the top left 
corner cell selects all wells in the plate.

►► �Right-click: Displays context menu. 

►► �Double-click: Set selected sample to be the Active 
Sample.

►► �Drag: Drag to select multiple wells in a rectangular 
range.

►► �Ctrl + Click: Hold Ctrl to select multiple individual 
wells.

►► �Shift + Click: Hold Shift to select consecutive wells 
between two wells.

Work List: View and edit Work List.

►►►
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Icon Description 

Samples Created Order: Selects whether to automati-
cally proceed horizontally across the plate or vertically 
across the plate when creating new samples.

New Sample(s) on Selected Well(s): Creates new sam-
ples on the selected wells. The created samples will 
have the same template as the Active Sample with the 
same compensation matrix, report, data analysis, and 
Cytometer Setting. The samples will be created in the 
specimen with name specified in Specimen Name box. 
If specified specimen name is empty or does not exist, a 
new specimen will be created. The created sample name 
will use the name specified in the Sample Name box as 
a prefix. If the sample name box is empty, the default 
sample name prefix (sample 1, sample 2, …) will be used.  
Without Template: Creates new samples on the selected 
wells without template applied. The compensation ma-
trix, report, and data analysis template will be empty. But 
the cytometer setting will be the same as the current cy-
tometer setting in the Cytometer Setting panel.

Delete Sample(s) on Selected Well(s): Deletes the se-
lected samples from the selected wells. If one well has 
multiple samples defined, only the selected sample will 
be deleted.

Copy Sample(s) on Selected Well(s): Copies templates of 
selected samples from the selected wells. If no sample 
has defined in the selected wells, this function is dis-
abled. If part of selected wells has samples defined, only 
the wells which have sample defined will be copied.

Paste Sample(s) on Selected Well(s): Pastes sample 
template or sample events to the selected wells accord-
ing to copied content.

►►  If all the selected wells have samples defined, 
then it applies templates of the copied samples to 
the selected samples of selected wells one by one 
repeatedly.

►►  If all the selected wells have no samples defined, 
then it creates samples with the same templates as 
copied samples on the selected wells. The samples 
will be created in the specimen with the name speci-
fied in Specimen Name box.  

►► If part of the selected wells have samples defined 
and the rest part have no samples defined, or the 
selected samples of the selected wells are in diffe-
rent specimen, this tool will be disabled.

►► If Copy Events is selected from context menu of a 
well, this tool will be available when only one well is 
selected and the selected sample of the selected 
well contains no events.  

►►►
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Icon Description 

Duplicate Sample(s) on Selected Well(s): Creates new 
samples on empty wells, duplicating the template of the 
selected samples of the selected wells. 
If part of the selected wells have samples defined and 
the rest part have no samples defined, or the selected 
samples of the selected wells are in different specimen, 
this tool will be disabled.  
If the specimen contains more than one sample, and all 
the samples are selected, clicking this icon will create 
duplicated samples under a newly created specimen.
New Plate: Creates new plate and specimen, and creates 
new samples in the new specimen, duplicating the tem-
plate of the selected samples of the selected wells. The 
new samples have the same well ID with the selected 
wells.

Show Run Order: When selected, a blue outline shows 
on the icon  . The sample acquisition sequence will be 
shown in the plate view.

Mode: User is allowed to select the working mode (Stan-
dard, High- Throughput and Custom) of the NovoSam-
pler Pro in this area. Default mixing parameters (i.e. 
Mixing Speed, Acceleration, Duration, Mix and Rinse pat-
tern), Stop condition and Flow Rate setting will be auto-
matically applied when Standard or HT mode is selected. 
User can only customize these settings when Custom 
mode is selected. 

 �Selecting the working mode of NovoSampler 
Pro is only available before the sample is cre-
ated.

This area is designed to input plate information. The left 
drop-down box is the Plate ID. The Plate ID is a positive 
integer and can be modified by highlighting the area and 
entering a new number. 
The middle drop-down box is the Plate Type. The drop-
down box lists all the available plate type defined in the 
Manage Plate Types window from the Instrument → No-
voSampler Pro menu. Pull down the list and select the 
corresponding plate type for the experiment. The right 
box is the Plate Name. Input plate name in this box to 
help identify the plate.

 �The plate type cannot be modified once the 
sample acquisition has begun.

This area is designed to input the specimen and sample 
information. The left drop-down box is the Specimen ID 
and Specimen Name, separated by a colon. The right box 
is the Sample Name.
When creating new samples, the samples will be cre-
ated in a specimen with specimen name specified in the 
Specimen Name box. If the Specimen Name box is empty 
or does not exist, a new specimen will be created. The 
default new specimen name is Specimen1, Specimen2,… 
The default sample name is Sample1, Sample2,…

►►►
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Icon Description 

Mix: Sets the mixing conditions. Mix can be set for None 
(no mixing), 1 Cycle, 2 Cycles, 3 Cycles for every defined 
number of wells or every defined number of minutes.

 �Default mixing conditions (i.e. Mix 1 Cycle Ev-
ery 1 Well) will be automatically applied and 
cannot be modified by user when Standard or 
HT mode is selected.

Rinse: Sets the rinse cycle to clean the sample injection 
probe. Rinse can be set for None (no rinse), 1 Cycle, 2 
Cycles, 3 Cycles for every defined number of wells. 

 �Default rinse conditions (i.e. Rinse 1 Cycle Ev-
ery 1 Well when Standard mode is selected, or 
None when HT mode is selected) will be au-
tomatically applied and cannot be modified by 
user when Standard or HT mode is selected.

 �There is always one rinse cycle at the end of 
each plate run even the Rinse setting is set to 
None. 

Mixing Parameters: Sets the mixing parameters for the 
orbital shaker. When NovoSampler Pro works in Custom 
mode, these mixing parameters for each plate type are 
defined in the Manage Plate Type window from the In-
strument → NovoSampler Pro menu, and can be modi-
fied in this area for the current experiment. When No-
voSampler Pro works in Standard or HT mode, default 
mixing parameters will be automatically applied and 
cannot be modified by user. Please refer to Table 2.1 in 
this guide for more details.

Speed: The mix speed of the orbital shaker.

Acceleration: The acceleration time for the orbital shaker 
to reach the specified Mix Speed.

Duration: The mixing time for the orbital shaker to mix 
the sample in one cycle.

■

In addition to the Tools menu, the Plate Management panel also provides a rich 
set of context menu actions.

Context menu when a single well is selected

If the selected well has sample already defined, the right-click menu displays a list 
of the samples defined in the selected well and the software functions available 
to be used. This context menu is the same as the context menu by right-clicking 
a sample node in the Experiment Manager panel. From this context menu, you 
can quickly select the defined sample, open, close, delete, and create plots, copy 
and paste templates, copy and delete events, delete, rename and duplicate the 
sample, import template or the data from a FCS file, or export as a template or 
the data in FCS and CSV formats, move the sample to the selected specimen. For 
additional information regarding these functions, refer to the  Section 6.2.2 Right-
Click Menu in NovoExpress® Software Guide.
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If the selected well has no sample defined, the right-click menu has two items 
available, New and Paste. New will create new sample without a template. Paste 
will create a new sample with the same template as the copied sample. 

Figure 2-13 Context Menu when a Single Well which has Sample Defined is Selected

If the selected well has no sample defined, the right-click menu (Figure 2-14) gen-
erally has two items available, New and Batch Creation of New Specimens. New 
will create new sample without a template. Batch Creation of New Specimens 
allows user to create new specimen(s) with customized specimen and sample 
organization. Refer to Context menu when multiple wells are selected for more 
details on this function.

 � The Paste Sample Names will be available if user copied the sample name in 
previous operation.

Figure 2-14 Context Menu when a Single Well which has no Sample Defined is Selected
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Context menu when multiple wells are selected

Figure 2-15 Context Menu when Multiple Wells are Selected

►► New: Same as the New Sample(s) on Selected Well(s) tool in the toolbar.

►► Delete: Same as the Delete Sample(s) on Selected Well(s) tool in the toolbar.

►► �Batch Creation of New Specimens: Create new specimen(s) with customized 
specimen and sample organization. When clicked, software will prompt fol-
lowing window (Figure 2-16). User need define  item(s) in this window, click 
OK to complete or cancel to go back to the previous window.

Figure 2-16 Dialog Window for Batch Creation of New Specimens

•	 Do not import template: Select this option if no templates need to be imported

•	� Import sample template: Select this option if sample template needs to be im-
ported for newly created samples. Click  to load the template file (.nct file).

•	 �Import specimen template: Select this option if specimen template needs to be 
imported for newly created specimens. Click  to load the template file (.nct 
file).

•	� Specimen order: direction of creating the specimens for selected samples. 
For example, when A1, A2, B1, B2 are selected, and Horizontal is selected as 
the specimen order, and 2 samples per specimen is selected, software will au-
tomatically create two new specimens and new samples in these four wells. 
Sample A1 and A2 will be placed under the first newly created specimen. Sam-
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ple B1 and B2 will be placed under the second newly created specimen.

•	� Prefix of specimen name: Set the prefix for the name of the newly created 
specimen(s). 

•	 �Prefix of sample name: Set the prefix for the name of the newly created 
sample(s).

•	� Number of samples per specimen: Set the number of newly created samples per 
each newly created specimen.

►► �Delete Specimen: Delete the selected specimen and associated samples on 
selected wells.

►► �Copy Template: Same as the Copy Sample(s) on Selected Well(s) tool in the 
toolbar.

►► Paste: Same as the Paste Sample(s) on Selected Well(s) tool in the toolbar.

►► �Paste Sample Names: Rename samples of the selected wells with the names 
copied from a spreadsheet program like Microsoft Excel, or create new sam-
ples with copied name on selected wells if there is no sample defined. If part 
of selected wells have samples defined and the rest part have no samples 
defined, this menu will be disabled.

 � If you have an Excel spreadsheet defining the sample names in a plate format, 
use Paste Sample Names function from the right-click context menu to copy 
the sample name from the spreadsheet and quickly create new samples for a 
plate in NovoExpress Software. 

►► �Duplicate: Same as the Duplicate Sample(s) on Selected Well(s) tool in the 
toolbar.

►► �Move to Specimen: Move the selected sample(s) to the selected specimen or 
new specimen.

2.6	 Work List

The Work List can be used to set up the sample for a plate. The Work List allows 
users to create new samples, import specimens or samples from a template, du-
plicate specimens or samples, and copy and paste sample information. To open 
the Work List window, click the Work List button from Home → Experiment → 
Work List, or alternatively, click the Work List icon  , from Experiment Manager 
panel or Plate Manager panel. The Work List window is shown in Figure 2-17.
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Figure 2-17 Work List Window

Compared to the Work List in NovoExpress Software with no NovoSampler Pro 
installed, there are three additional icons  shown on the menu bar. The 
created Work List with NovoSampler Pro installed will also include the Plate ID 
and Well ID columns. The other functions remain the same. Refer to the Section 
4.2 Work List in NovoExpress® Software Guide for the detailed information and 
functions to create a Work List. The table below describes the functions of the 
three additional icons.

Icon Description 

Well ID Setting Direction
When new samples are created in the Work List, the Well ID will be assigned 
sequentially. Use the Well ID Setting Direction button  in the Work List win-
dow to set whether new samples are created in a row-by-row sequence or a 
column-by-column sequence for a plate.

Automatic Setting Well ID
When selected, a blue outline will show on the icon. When Well ID of a sample 
is modified manually, the NovoExpress Software will automatically assign 
new Well ID for blank samples below that sample in an order set in the Well ID 
Setting Direction based on the plate type information. 

►►►
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Icon Description 

Plate View
Click this icon opens the Plate View window. Plate View window is read only 
and is used to check the information of the blank samples on a plate view.
The Plate drop-down menu lists the Plate ID for all the created plates. Select 
a Plate ID from the drop-down menu and view the sample information for 
this plate. Check the Show Specimen Name checkbox to enable the specimen 
name associated with each well to be shown. Check the Display sample has 
data checkbox to also show samples which have collected data.

Figure 2-18 Plate View Window

■

 �The Plate ID and Well ID in the Work List can be modified to assign Plate ID 
and Well ID for the samples. 

 �When collecting repeats from a sample well is desired, multiple samples can 
be assigned to the same Well ID.

2.7	 Statistical Tables

The statistical tables provide a summary for multiple samples, gates, and param-
eters, enabling batch analysis and data comparison. For data generated using 
NovoSampler Pro,  two additional columns Plate ID and Well ID are available. 

To show or hide Plate ID or Well ID column in statistical table, click the Show 
Columns button  , and select or deselect the column from the drop-down menu. 
The drop-down menu is shown in Figure 2-19.

Figure 2-19 Drop-down Menu of the Show Columns Button
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 �For additional information regarding the Statistical Tables, refer to the Section 
5.6 Statistical Tables in NovoExpress® Software Guide.

2.8	 Options

Additional settings for NovoSampler Pro operation can be set by clicking Settings 
→ Options → Experiment from the menu. The window is shown in Figure 2-20.

Figure 2-20 Define Default Experiment Settings using Options Window

The following settings are specific to the operation of the NovoSampler Pro:

►► �Always remind to check plate type for first run when using NovoSampler: With 
this setting checked, a window will be prompted to remind user to check if the 
correct plate type is selected before starting the experiment.

 �It is highly recommended to enable this setting to remind user to check and 
make sure the correct plate type is selected for the experiment to avoid colli-
sion of the sample injection probe.
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3.	 Sample Acquisition

This chapter describes the sample acquisition process using NovoSampler Pro, 
including the following sections: 

►► �Preparation

►► �Experiment Setup

►► �Instrument QC Test

►► �Single Sample Acquisition

►► �Edit Work List

►► �Automatic Sample Acquisition

►► �Analysis of Data

►► �Shutdown

In this chapter, a 96-well plate will be used for sample acquisition. Firstly, a QC 
Test using ACEA Flow Cytometer QC Particles will be performed in well A1. 
The ACEA QuadriTest CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent (Cat # 
8730008) will be used to prepare a single sample of human peripheral blood in 
well A2. The sample will be used to determine the gate for the lymphocyte sub-
population. Well A3, A4, A5, and A6 are compensation beads labeled respectively 
with FITC, PE, PerCP, and APC conjugated antibodies for automatic fluorescence 
compensation using NovoExpress software and generating the compensation 
matrix. In well B1 to E12, 48 samples will be created and analyzed for 24 speci-
mens with 2 samples in each specimen. For each specimen, one sample will be 
stained with ACEA QuadriTest CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent 
(Cat # 8730008) and the second sample will be stained with ACEA QuadriTest 
CD3 FITC/CD16+CD56 PE/CD45 PerCP/CD19 APC Reagent (Cat # 8730009).

3.1	 Preparation

Before using the NovoSampler Pro for sample acquisition, please be familiar with 
the following operation and information:

►► �NovoCyte Flow Cytometer startup and shutdown procedures

►► �QC testing procedure

►► �NovoExpress Software’s Cytometer Settings, Work List, and Experiment Man-
ager panels

►► �NovoSampler Pro sample volume requirements

 �For additional information regarding the operation of the NovoCyte Flow Cy-
tometer, refer to the Section 2 Instrument Operation in NovoCyte® Flow Cytom-
eter Operator’s Guide.

 �For additional information regarding using the NovoExpress Software, refer to 
the NovoExpress® Software Guide.

Minimum Sample Volume Requirements for the NovoSampler Pro

►► �For samples in a 12 × 75 mm tube, the minimum sample volume is 90 µL.
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►► �For samples in a 96-well plate, the minimum sample volume in a well is 90 µL.

►► For samples in a 48-well plate, the minimum sample volume in a well is 210 µL.

►► �For samples in a 24-well plate, the minimum sample volume in a well is 310 
µL.

►► �The recommended sample concentration range is 1 × 106 to 5 × 106 cells/mL.

Confirm Sufficient Sheath Fluid Volume

During sample acquisition, the NovoCyte Flow Cytometer consumes about 0.4 li-
ters of sheath fluid per hour. A warning will appear if the sheath fluid in the sheath 
fluid container is less than 0.9 liters. To avoid the termination of the plate run due 
to the lack of sheath fluid or a full waste container, before starting an automatic 
sample acquisition with NovoSampler Pro, always make sure there is a sufficient 
volume of sheath fluid in the sheath fluid container and the waste container has 
enough capacity.

3.2	 Experiment Setup

Start the NovoCyte Flow Cytometer and NovoExpress Software according to the 
process described in the NovoCyte® Flow Cytometer Operator’s Guide. As the flow 
cytometer powers up, the NovoSampler Pro will also start and be ready to use.

Before sample acquisition using the NovoSampler Pro, select the plate type from 
the Plate Manager panel (Figure 3-1). If the Plate Manager panel is not visible, 
check the box from View → Show → Plate Manager to open it. The plate type 
can then be selected from the Plate Type drop-down menu. In this example, the 
96-well plate (U-bottom) is selected. For other compatible plate types, refer to 
Section 1.1 Hardware Overview in this guide.

Figure 3-1 Plate Manager Panel
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 �Before starting sample acquisition, ensure that the correct plate type is select-
ed. An incorrectly selected plate type may result in the collision of the sample 
injection probe with the plate and could cause damage to the instrument.

3.3	 Instrument QC Test

Quality Control (QC) test is used to monitor the performance of NovoCyte Flow 
Cytometer. Use the ACEA Flow Cytometer QC Particles daily after startup to QC 
the NovoCyte instrument and make sure it functions properly.

3.3.1	 Prepare QC Particles

To prepare the ACEA Flow Cytometer QC Particles for the QC test:

1 Label a 12 × 75 mm tube for the QC test. Add 1 mL dilution buffer (0.8 mL PBS and 
0.2 mL NovoRinse solution) into the tube.

2 Take one bottle of QC Particles from storage. Invert the bottle a few times by hand 
to mix the particles thoroughly.

3 Add two drops of QC Particles (Cat. # 8000004) into the test tube.

4 Vortex the test tube to mix the QC Particles thoroughly.

5 Transfer 150 µL of the QC Particles sample from the test tube to the A1 well of a 
96-well plate and run the QC Test immediately. If the prepared QC Particles sample 
is not intended to be run immediately, store the sample in a 2-6°C refrigerator away 
from light. The prepared QC Particles sample should be used within four hours after 
preparation.

■

3.3.2	 Run the QC Test

To load the sample plate and run the QC test:

1 Open the cover of the NovoSampler Pro and place the sample plate on the orbital 
shaker.

 �Make sure the plate is positioned with the correct orientation onto the 
orbital shaker with the clips of the orbital shaker holding the plate tightly.

►►►
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2 In the NovoExpress Software, open the QC Test window by clicking Instrument → 
Operation → QC Test button. The QC Test window is shown in Figure 3-2.

Figure 3-2 QC Test Step 1

3 In the window, enter the name of the operator, select the QC Particles Lot ID, and 
select the Well ID of the QC Particles sample. In this example, the Well ID is A1. Click 
Next and follow the software prompt to run the QC test and view the test reports. For 
more information regarding the QC Test function, refer to the Section 2.3 Instrument 
Quality Control  in NovoCyte® Flow Cytometer Operator’s Guide.

■

3.4	 Single Sample Acquisition

This section describes the collection of a single sample of human peripheral 
blood prepared using the ACEA QuadriTest CD3 FITC/CD8 PE/CD45 PerCP/CD4 
APC Reagent. The sample will be used to set up the gate for the lymphocyte 
subpopulation. Based on this single sample, settings can be optimized for other 
human peripheral blood samples in the example described in this chapter, includ-
ing setting up a proper acquisition threshold and determining the gates for the 
lymphocyte subpopulation.

To begin the collection of the single sample in well A2, follow the procedure:

1 After the completion of the QC Test, the orbital shaker will return to the home posi-
tion. After the orbital shaker moves to home position, open the NovoSampler Pro 
cover and remove the sample plate.

2 Add 150 µL of the sample of human peripheral blood stained with ACEA QuadriTest 
CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent to well A2 of the sample plate.

3 Place the sample plate onto the orbital shaker of the NovoSampler Pro and close 
the cover. 

4 In NovoExpress Software, create a new experiment file. Click the Next Sample button 
on the Cytometer Control panel to create a new sample (named A1: Sample1 by de-
fault) and specimen (named Specimen1 by default). Save the file to a specific folder 
on NovoCyte workstation by clicking File → Save. 

►►►
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5 Setting conditions for sample acquisition is described in the Section 3 Running Sam-
ples in NovoCyte® Flow Cytometer Operator’s Guide. In this experiment, the param-
eters should be set to collect the Height parameter from FSC, SSC, B530, B72, B675, 
and R675. The aliases for B530, B572, B675, and R675 could be modified to CD3 
FITC, CD8 PE, CD45 PerCP, and CD4 APC, respectively. Set the stop condition to 50 
µL. Set the sample flow rate to Low. Set the threshold to collect samples with FSC-H 
greater than 100,000.

 The volume stop condition must be set when using NovoSampler Pro.

6 Change the sample information. Set the Well ID as A2 using one of the two following 
methods :

►► Click Sample1 in the Experiment Manager panel to select the node (Figure 3-3). 
Right-click and select Rename. The Well ID can now be modified to A2.

Figure 3-3 Modify Well ID in the Experiment Manager Panel

►► In the Active Sample Information window of the Cytometer Control panel (Figure 
3-4), click the sample name and modify the Well ID to A2.

Figure 3-4 Modify Well ID in the Cytometer Control Panel

 �The well can be named from a range depending on the plate type se-
lected from the Plate Manager panel. If a 96-well plate is selected, the 
wells can range from A1 to H12. If a 24-well plate or the 24-well tube rack 
is selected, the wells can range from A1 to D6.

7 In the Cytometer Control panel, click the Run Single Well button  to start 
sample acquisition from well A2.

8 In the Workspace, create a density plot by clicking the Density Plot button  from 
the toolbar. Change the x-axis parameter to CD45 PerCP-H and the y-axis parameter 
to SSC-H (Figure 3-5). Use the Zoom In tool  , to display the appropriate coordinate 
range for the sample. Draw an Elliptical Gate to gate the lymphocyte population on 
the plot, and rename the gate as Lymphocyte.

Figure 3-5 Create Density Plot and Draw Lymphocyte Gate

■
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3.5	 Edit Work List

In this section, the Work List will be used to create auto compensation samples 
and experiment samples.

3.5.1	 Creating Compensation Control Samples

To create the auto compensation samples, click Home → Compensation → Auto 
Compensation to open the New Auto Compensation window. In the window, se-
lect the four parameters used in the experiment, FITC (B530), PE (B572), PerCP 
(B675), and APC (R675). The software will then create four single-stained sam-
ples to be used to calculate fluorescence compensation, and the software will 
automatically assign the samples to wells A3 to A6. The four created samples 
will be added to the Compensation Specimen node in the Experiment Manager 
panel as shown in Figure 3-6.

 �For detailed information about the auto compensation, refer to Section 3.5.1 
Automatic Fluorescence Compensation in NovoCyte® Flow Cytometer Opera-
tor’s Guide.

Figure 3-6 Creating Compensation Control Samples

3.5.2	 Creating Experiment Samples

New samples could be created through the Work List window or through the Plate 
Manager panel.

Create experiment samples through the Work List window

To open the Work List, click the Work List button from Home → Experiment → 
Work List. Alternatively, the Work List window can be opened by clicking the Work 
List button  , from the Experiment Manager panel or Plate Manager panel.

After opening the Work List window:

1 Set the Well ID Setting Direction to Horizontal, and enable Automatic Setting Well ID 
(a blue outline shows on the icon).

►►►
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2 Right-click the header in the row for Specimen1 Sample1 and select Copy. Move the 
cursor to the last empty row below Specimen1 Sample 1, right-click the header and 
select Insert Copied Rows as Specimen. The software will create a new specimen, 
named Specimen2, and the specimen will contain a sample, named Sample1, which 
will contain the Lymphocyte gate from Specimen1 Sample1. 

3 Double-click the Specimen Name cell of the Specimen2 Sample1 row to modify the 
specimen name. Rename the specimen as Name1. Double-click the Stop Condition 
cell and set the stop condition to 5,000 events in the Lymphocyte gate.

4 Click the header of the Name1 Sample1 row to select the entire row. From the tool-
bar of the Work List window, click the Duplicate as Sample button . A new sample 
will be created within the Name1 specimen and named Sample2. In the new sample 
Name1 Sample2, modify the alias under the B572 and R675 parameters. Rename the 
alias for B572 as CD16 + CD56 PE and the alias for R675 as CD19 APC.

5 Select both Name1 Sample1 and Name1 Sample2 rows. Click the Duplicate as Speci-
men button  from the toolbar 23 times to create the remaining 23 specimens and 
46 samples. Rename each specimen as Name2, Name3, etc.

6 In the Name1 Sample1 row, rename the Well ID to B1. The remaining sample wells 
will automatically update. The complete Work List is shown in Figure 3-7.

Figure 3-7 Work List Window after Experiment Samples Created

7 Check the Work List to ensure the settings are correct, and click the Apply Modifica-
tions button  from the toolbar to save the changes made to the Work List. You will 
see the new samples automatically showing up in the Experiment Manager panel 
(Figure 3-9).

■

Create experiment samples from the Plate Manager panel

1 Open the Plate Manager panel by checking the View → Show → Plate Manager box 
if it is not visible.

2 Double click well A2 to set sample Specimen1 Sample1 as the Active Sample. Click 
well B1, input Name1 in the specimen name box, input Sample1 in the sample name 
box, and click the New Sample(s) on Selected Well(s) button  in the Plate Manager 
panel toolbar to create a new sample with the same template as sample Specimen1 
Sample1 in well B1.

3 In the Cytometer Setting panel, change the event number stop condition to 5000 
events on gate Lymphocyte.

►►►
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4 Set the Samples Created Order tool  in the Plate Manager panel toolbar to Hori-
zontal.

5 Click the Duplicate Sample(s) on Selected Well(s) button  in the Plate Manager 
panel toolbar, rename the created sample as Sample2, modify alias of B572 as 
CD16+56 PE and modify alias of R675 as CD19 APC.

6 Select both well B1 and B2, click the Duplicate Sample(s) on Selected Well(s) button  , 
in the Plate Manager panel toolbar 23 times to create the remaining 23 specimens 
and 46 samples. Sequentially rename each of the newly created specimens as 
Name2, Name3, etc. The created samples in the Plate Manager panel are shown in 
Figure 3-8.

7 Set the Mixing parameters as shown in Figure 3-8 as well.

Figure 3-8 Plate Manager Panel after Experiment Samples Created

■

The Experiment Manager panel will be updated with the newly created samples. 
The Experiment Manager panel is shown in Figure 3-9.

Figure 3-9 Experiment Manager Panel after Experiment Samples Created
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 �In the Experiment Manager panel, a variety of templates can be used to eas-
ily perform fluorescence compensation and data analysis. Please refer to the 
Section 6 Experiment Manager in NovoExpress® Software Guide.

 �If the sample acquisition conditions are different between samples, the Work 
List allows to individual collection conditions to modify individual samples.

 �For additional information regarding the Work List, refer to the Section 4.2 
Work List in NovoExpress® Software Guide.

3.5.3	 Plate View

Plate view provides an intuitive view of the sample wells. To open the plate view, 
click the Plate View button from Home → Experiment → Plate View. In plate view, 
if the experiment contains multiple plates, the displayed plate can be switched 
using the drop-down menu. The plate view is shown in Figure 3-10. 

Figure 3-10 Plate View Window

 �If a stop condition has not been set for a sample, the sample well will not be 
set and the sample will not be displayed in the plate view.

3.6	 Automatic Sample Acquisition

This section will describe the automatic sample acquisition procedure.
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1 Remove the sample plate from the NovoSampler Pro, and load the plate accord-
ing to the layout set for the experiment. In this experiment, the four single-stained 
samples for fluorescence compensation are in wells A3 to A6. The 48 samples from 
24 different specimens are in wells B1 to E12. For each specimen, the first sample 
is stained with ACEA QuadriTest CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC reagen 
and the second sample is stained with ACEA QuadriTest CD3 FITC/CD16+CD56 PE/
CD45 PerCP/CD19 APC Reagent. After preparing the sample plate, load the plate 
onto the orbital shaker of the NovoSampler Pro and close the cover.

2 In the Cytometer Control panel, click the Run Plate button  . The Select 
well(s) to run window will open as shown in Figure 3-11. In the window, select the 
wells to be collected. Wells selected for collection will be displayed in blue, unselect-
ed wells will be displayed in white, and wells that are not available for collection will 
be displayed in gray. In this experiment, select all of the samples from A3 to E12. 
Click the Run button to begin sample acquisition. The selected samples will be col-
lected in the order listed in the Work List.

Figure 3-11 Window for Selecting Wells to Run

 �Click the header row or header column to select all of the available wells 
in the row or column. Click the top-right corner cell of the grid  , to 
select all available wells on the plate.

3 The automatic Sample acquisition workflow with NovoSampler Pro is shown in Fig-
ure 3-12. The process will begin with mixing the sample. The orbital shaker with the 
sample plate will then move to align the sample injection probe with the first sample 
well and it will be followed by sample acquisition. After sample acquisition is com-
pleted, the instrument will rinse the sample injection probe. The NovoSampler Pro 
will then mix the sample, move the orbital shaker with the sample plate to align the 
sample injection probe with the next sample well, and begin the sample acquisition. 
The process will continue until all of the selected samples are acquired. The fre-
quency of mixing and rinsing will depend on the settings in the Plate Manager panel, 
which is opened from View → Show → Plate Manager.

►►►
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Figure 3-12 Work Flow of Automated Sample Acquisition Procedure with NovoSampler Pro

4 During automated sample acquisition, when starting acquiring a new sample, a win-
dow shown in Figure 3-13 will be prompted. In the prompted window, user can deter-
mine if the new sample will become the Active Sample. Active Sample is the sample 
shown in the Workspace for data analysis and indicated by a red arrow  on the left 
of a sample in the Experiment Manager panel. Click Yes to make the sample to be ac-
quired as the Active Sample so that you can observe the data for each new sample 
when it is acquired. Click No to keep the sample currently in analysis as the Active 
Sample so that you can continue working on the data analysis, in the meanwhile the 
rest of the samples are been acquired. If there is no user interference within 10 sec-
onds after this window appears, NovoExpress Software will automatically make the 
new sample to be acquired as the Active Sample. Check the Do not show this again 
in current run checkbox and click Yes or No to make your selection as default for the 
rest of the plate run.

Figure 3-13 Window for Options on Determining the Active Sample during a Plate Run

■

 �To pause automated sample acquisition, click Pause button (Figure 3-14) 
in the Experiment Control panel. The Pause button then changes to a Re-
sume button. The automated sample acquisition will be paused after current 
sample acquisition is completed. To stop current sample acquisition imme-
diately, click Stop Single Well button in the Experiment Control panel. To re-
sume automated sample acquisition, click Resume button. In this case, the 
Select well(s) to run window will not prompt. The software will automatically 
continue to run the rest wells in the experiment. To stop automated sample 
acquisition, click Stop button. 
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Figure 3-14 The Cytometer Control Panel after Automated Sample Acquisition Started

3.7	 Analysis of Data

After the sample is collected, data analysis can be performed with NovoExpress 
Software. NovoExpress software provides tools for batch data analysis of mul-
tiple samples generated with NovoSampler Pro, such as analysis template, batch 
report, Statistical Table, etc. The data analysis process is summarized in Figure 
3-15.

Figure 3-15 Data Analysis Procedure

 �The Well ID and Plate ID information is included in the exported FCS files. 
Third party software could read this information for data analysis after im-
porting the FCS files.

 �For additional information regarding data analysis, please refer to the Novo-
Cyte® Flow Cytometer Operator’s Guide or the NovoExpress® Software Guide.
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3.8	 Shutdown 

When all experiments are completed for the day, shut down the system using the 
following procedure:

1 Shut down the NovoCyte Flow Cytometer
Press the power button on the NovoCyte Flow Cytometer, or click on the Shut Down 
button  , in the Instrument tab of the NovoExpress Software. The light in the power 
button will start flashing, and the instrument will automatically start the shutdown 
cleaning process. After the shutdown cleaning process is completed, the instrument 
will be turned off automatically.

 �The shutdown cleaning process will automatically clean the tubing in-
side the system without the need for user intervention.

 �Check the Shut down NovoCyte after plate run checkbox in Cytometer 
Control panel to automatically activate the shutdown function after all 
the defined samples have been acquired. Refer to Section 2.3 Cytometer 
Control Panel in this guide for more information.

2 Close NovoExpress software.

3 Shut down the NovoCyte workstation. Empty the waste container.

 �For detailed information on emptying the waste container, please refer to 
the Section 2.1.3 Empty Waste in NovoCyte® Flow Cytometer Operator’s 
Guide.

■
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4.	 Cleaning NovoSampler Pro

The NovoSampler Pro frequently comes into contact with the experimental sam-
ple. To prevent corrosion of the instrument, periodically clean the outer and inner 
surfaces of the NovoSampler Pro.

Materials

►► NovoRinse solution

►► DI water

►► Clean soft cloth

Procedure

1 Turn off NovoCyte Flow Cytometer and unplug the power cable.

 �To prevent possible injury and damage to the instrument, turn off the 
power of the NovoCyte Flow Cytometer and unplug the power cable 
before cleaning or moving the instrument.

2 Prepare a damp soft cloth with NovoRinse solution. Wipe the top surface of the or-
bital shaker and accessible outer and inner surfaces of the NovoSampler Pro.

3 Prepare a damp soft cloth with DI water. Wipe the surfaces again.

4 Wipe the surfaces one more time with a dry soft cloth.

■

 �The NovoSampler Pro and NovoCyte instrument may come into contact 
with biohazardous material. During the cleaning procedure, use appropri-
ate protective equipment, including gloves, clothing, and eyewear.

 �Do not wipe the NovoSampler Pro using isopropyl alcohol or ethanol.
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5.	 Troubleshooting

This chapter will describe errors and possible solutions related to the NovoSam-
pler Pro. For additional support, please contact your local ACEA technical sup-
port.

 �For technical support contact information, refer to the Technical Support sec-
tion in the Prologue of this guide.

For errors related to NovoCyte Flow Cytometer, refer to the NovoCyte® Flow Cy-
tometer Operator’s Guide. For errors related to the software, refer to the NovoEx-
press® Software Guide.

Table 5-1 provides guidance on troubleshooting the NovoSampler Pro. Table 5-2 
lists the message IDs and the associated software prompted messages. 

 �Please contact ACEA Technical Support if issues are not resolved after per-
forming the recommended solutions or if there are any issues which are not 
listed in these two tables.

 �Investigate possible causes and perform the recommended solutions in the 
given order.

Observation Possible Causes Recommended Solutions 

Sample injection 
probe is not prop-
erly aligned with 
the wells or tubes 

Plate or tube rack is 
not loaded correctly.

Load the plate or tube rack with the correct 
orientation. Make sure the plate or tube rack is 
seated onto the sample tray properly. 

NovoSampler Pro is 
not calibrated.

Click Instrument → NovoSampler Pro → Cali-
brate in the NovoExpress Software to re-cali-
brate the NovoSampler Pro.

■

Table 5-1 Troubleshooting Guide for NovoSampler Pro

Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x0001 Collision of SIP The movement of 
the SIP is blocked 
by some obstacles

Locate and clear the obstacles. Click 
the OK button in the prompted dialog 
box or wait 10 seconds for automatic 
error handling. The instrument will move 
the SIP to the home position. This pro-
cedure will take about 3 minutes. 

Incorrect plate 
selected in plate 
manager

Select the correct plate in the plate 
manager window.

Incorrect position-
ing of plate in 
NovoSampler Pro

►► Position the plate on the shaker cor-
rectly. Ensure the plate is seated flat 
on the stage inside the clamps.

►► Re-calibrate NovoSampler Pro. 

►►►
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Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x0001 Collision of SIP Dirty SIP or SIP 
wash  apparatus

Clean the SIP or SIP wash apparatus 
following the procedures described in 
Section 1.1 Preventative Maintenance in 
NovoCyte® Flow Cytometer Maintenance 
Guide.

0x0002 Running out of 
NovoFlow 

NovoFlow solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoFlow container following 
the procedures described in Section 
2.1.2 Add Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s Guide.

NovoCyte Fluidics 
Station is not work-
ing properly

Replace the NovoCyte Fluidics Station.

0x0003 Running out of 
NovoRinse 

NovoRinse solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoRinse container follow-
ing the procedures described in Section 
2.1.2 Add Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s Guide.

NovoCyte Fluidics 
Station is not work-
ing properly

Replace the NovoCyte Fluidics Station.

0x0004 Running out of 
NovoClean

NovoClean solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoClean container follow-
ing the procedures described in Section 
2.1.2 Add Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s Guide.

NovoCyte Fluidics 
Station is not work-
ing properly

Replace the NovoCyte Fluidics Station.

0x0005 Waste contain-
er is full 

Waste container is 
too full to continue 
to run any samples

Empty the waste container following the 
procedures described in Section 2.1.3 
Empty Waste in NovoCyte® Flow Cytom-
eter Operator’s Guide.

NovoCyte Fluidics 
Station is not work-
ing properly

Replace the NovoCyte Fluidics Station.

0x0006 System voltage 
is out of range

System Error ►► Restart the NovoCyte instrument.

►► Contact ACEA technical support if 
the error persists.

0x0007 System electric 
current is out 
of range

System Error ►► Restart the NovoCyte instrument.

►► Contact ACEA technical support if 
the error persists.

0x0008 Firmware 
configuration 
error

System Error ►► Restart the NovoCyte instrument.

►► Contact ACEA technical support if 
the error persists.

0x0009 
0x000A
0x000B

…… laser self 
test error

Specified laser is 
not functioning 
properly

The instrument will automatically reset 
the laser and run a laser self-test. It 
takes approximately 5 to 10 minutes. 

►►►



51

55

Troubleshooting
﻿

Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x000C 
0x000D
0x000E

….laser is not 
connected

Specified laser is 
not detected

►► Restart the NovoCyte instrument.

►► Contact ACEA technical support if 
the error persists.

0x000F NovoSampler 
communica-
tion lost

The cable between 
the NovoSampler 
(Pro) and NovoCyte 
Flow Cytometer is 
not securely con-
nected

Reconnect the cable between the 
NovoSampler (Pro) and NovoCyte Flow 
Cytometer. 

NovoSampler (Pro) 
is not communicat-
ing with NovoCyte

►► Restart the NovoCyte instrument.

►► Contact ACEA technical support if 
the error persists.

0x0010 NovoSampler 
(Pro) has not 
been calibrated

NovoSampler (Pro) 
is newly installed or 
re-connected.

Follow the prompted instructions to 
calibrate the NovoSampler (Pro).

0x0011 NovoSampler 
(Pro) calibra-
tion failed……

NovoSampler (Pro) 
is not installed 
properly

Re-install and calibrate the NovoSam-
pler (Pro) following the procedures 
described in Section 1.2 Installation in 
NovoSampler® Operator’s Guide or No-
voSampler® Pro Operator’s Guide.

The NovoSampler 
(Pro) cover was 
opened during 
calibration.

Close the NovoSampler (Pro) cover and 
redo the calibration.

0x0012 The movement 
of plate is out 
of range

The movement of 
the orbital shaker is 
blocked.

►► Check the path of the orbital shaker 
to make sure there are no objects 
blocking the movement. Clear the 
block if there is any. 

►► Click Instrument → NovoSampler Pro 
→ Calibrate in NovoExpress Soft-
ware to re-calibrate the NovoSam-
pler (Pro).

NovoSampler (Pro) 
is not installed 
properly

Re-install and calibrate the NovoSam-
pler (Pro) following the procedures 
described in Section 1.2 Installation in 
NovoSampler® Operator’s Guide or No-
voSampler® Pro Operator’s Guide.

0x0013 Cover of 
NovoSampler 
(Pro) is opened 
during moving 
plate

The cover of 
NovoSampler (Pro) 
is open during mov-
ing plate

Close the NovoSampler (Pro) cover. No-
voSampler (Pro) will automatically reset 
and be ready for operation.

►►►
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Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x0014 Pressure is out 
of limit

Waste container 
is not correctly 
connected to the 
instrument

Check the quick coupling connectors to 
ensure the waste container is correctly 
connected to the instrument.

Sheath in-line filter 
is clogged 

Replace the sheath in-line filter follow-
ing the procedures described in Section 
1.2 Replacing Fluidic System Consum-
ables in NovoCyte® Flow Cytometer 
Maintenance Guide.

Flow cell is clogged Conduct Unclog from NovoExpress.

0x0015 NovoSampler 
firmware error

NovoSampler or 
NovoSampler Pro 
firmware is not 
working properly 

Re-install or upgrade the NovoSampler 
or NovoSampler Pro firmware.

0x0016 
0x0017 
0x0018

…… laser does 
not emit

Specified laser 
is not connected 
properly or laser 
is not working 
properly

►► Reconnect the laser cable properly.

►► Restart the instrument.

►► Contact ACEA technical support if 
the error persists.

0x0019 
0x001A 
0x001B

…… laser com-
munication 
error

Interference or bad 
connection or bad 
laser

►► Reconnect the laser properly.

►► Restart the instrument.

►► Contact ACEA technical support if 
the error persists.

0x001C Sample 
injection probe 
reset failed

Bad connection or 
optocoupler dam-
aged

►► Click the OK button in the prompted 
dialog box or wait 10 seconds for 
automatically error handling.

►► Restart the instrument.

►► Contact ACEA technical support if 
the error persists.

0x001D Sampling 
Pump reset 
failed

Bad connection or 
optocoupler dam-
aged

►► Restart the instrument.

►► Contact ACEA technical support if 
the error persists.

0x001E The SIP mod-
ule needs to 
be upgraded 
to support 
NovoSampler 
Pro

SIP module is not 
compatible with 
connected No-
voSampler Pro

Contact ACEA technical support for 
service.

0x0020 System 
initialization is 
paused

Liquid level in the 
reagent containers 
is not within normal 
range when Novo-
Cyte is powered up.

►► Make sure that the instrument rea-
gent containers are placed correctly 
and the liquid level in the containers 
is within the normal range.

►► Click OK on the prompted dialog to 
continue system initialization.

►►►
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Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x0021 Sheath fluid 
pump reset 
failed

Bad connection or 
optocoupler dam-
aged

►► Restart the instrument.

►► Contact ACEA technical support if 
the error persists.

0x0022 Resetting 
NovoSampler 
Pro to zero 
position failed

NovoSampler Pro 
is not working 
properly.

Click Reset. Restart the NovoSampler 
Pro.

0x0023 Resetting 
NovoSampler 
Pro to home 
position failed

NovoSampler Pro 
is not working 
properly.

Click Reset. Restart the NovoSampler 
Pro.

0x0100 Instrument 
cover opened

Instrument cover is 
open or not tightly 
closed

Close the instrument cover.

0x0101 NovoFlow run-
ning low

NovoFlow solution 
is below the pre-set 
volume limit

Refill the NovoFlow container following 
the procedures described in Section 
2.1.2 Add Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s Guide.

NovoCyte Fluidics 
Station not working 
properly

Replace NovoCyte Fluidics Station.

0x0102 NovoRinse run-
ning low 

NovoRinse solution 
is below the pre-set 
volume limit

Refill the NovoRinse container follow-
ing the procedures described in Section 
2.1.2 Add Instrument Reagents in this 
guide.

NovoCyte Fluidics 
Station not working 
properly

Replace NovoCyte Fluidics Station.

0x0103 NovoClean run-
ning low

NovoClean solution 
is below the pre-set 
volume limit

Refill the NovoClean container follow-
ing the procedures described in Section 
2.1.2 Add Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s Guide.

NovoCyte Fluidic 
Station is not work-
ing properly

Replace NovoCyte Fluidics Station.

0x0104 Waste con-
tainer is close 
to full

Waste is above the 
pre-set volume limit 

Empty the waste container following the 
procedures described in Section 2.1.3 
Empty Waste in NovoCyte® Flow Cytom-
eter Operator’s Guide.

NovoCyte Fluidics 
Station not working 
properly

Replace NovoCyte Fluidics Station.

0x0105 Cover of 
NovoSampler 
(Pro) opened 

Cover of NovoSam-
pler (Pro) is opened

Close the cover.

►►►
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Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x0106 NovoSampler 
(Pro) is discon-
nected when 
powered up

The NovoSampler 
(Pro) is disconnect-
ed when powered 
up

►► Shut down NovoCyte Flow Cytome-
ter. 

►► Reconnect the cable of the No-
voSampler (Pro) to NovoCyte flow 
cytometer. 

►► Turn on NovoCyte and follow the 
prompts to calibrate the NovoSam-
pler (Pro).

►► Contact ACEA technical support if 
the error persists.

0x0109 NovoCyte Flu-
idics Station is 
not connected

Cable between the 
NovoCyte Fluidics 
Station and the No-
voCyte instrument 
is not properly con-
nected 

►► Turn off the instrument.

►► Reconnect the cable between the 
NovoCyte Fluidics Station and the 
NovoCyte instrument. 

►► Power up the instrument.

►► Contact ACEA technical support if 
the error persists.

0x010A 
0x010B 
0x010C 
0x010D

… liquid level 
sensor failure

Specified liquid 
level sensor in the 
NovoCyte Fluidics 
Station or Novo-
Cyte Fluidics Cart 
is not working 
properly 

►► Reconnect the NovoCyte Fluidics 
Station or NovoCyte Fluidics Cart 
cable. 

►► Restart the NovoCyte instrument. 

►► Replace the NovoCyte Fluidics Stati-
on or NovoCyte Fluidics Cart.

►► Contact ACEA technical support if 
the error persists.

0x010F Sheath filter 
is clogged. 
Please replace 
the sheath 
filter and run 
the Priming 
procedure

Sheath in-line filter 
is clogged 

Replace the sheath in-line filter follow-
ing the procedures described in Section 
1.2 Replacing Fluidic System Consum-
ables in NovoCyte®  Flow Cytometer 
Maintenance Guide.

0x0110 Recovering col-
lision error

Plate stops at an 
incorrect position

No action is needed. Instrument will 
automatically recover the error.

0x0111 Orbital shaker 
homing posi-
tion reset 
failure

Orbital shaker of 
NovoSampler Pro 
is not working 
properly

No action is needed. The NovoSampler 
Pro can be used normally.

0x7000 NovoCyte 
Fluidics Cart 
firmware error

NovoCyte Fluidics 
Cart firmware is not 
working properly

►► Restart the instrument

►► Replace the NovoCyte Fluidics Cart

►► Contact ACEA technical support if 
the error persists.

►►►
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Message 
IDs

Software 
Messages

Possible Causes Recommended Solutions 

0x7001 NovoFlow 
liquid level 
sensor is not 
connected

NovoFlow liquid 
level sensor is not 
connected or does 
not work properly

►► Reconnect the NovoFlow liquid level 
sensor

►► Contact ACEA technical support if 
the error remains after reconnection. 
The sensor may be damaged and 
need to be replaced.

0x7002 Waste liquid 
level sensor is 
not connected

Waste liquid level 
sensor is not con-
nected or does not 
work properly

►► Reconnect the NovoFlow liquid level 
sensor

►► Contact ACEA technical support if 
the error remains after reconnection. 
The sensor may be damaged and 
need to be replaced.

0x7100 NovoCyte 
Fluidics Cart 
communica-
tion lost

NovoCyte Fluidics 
Cart is not properly 
connected to the 
instrument

►► Ensure the DVI cable between Novo-
Cyte Fluidics Cart and the instru-
ment is properly connected

►► Restart the instrument

►► Contact ACEA technical support if 
the error persists.

Communica-
tion error 
(code: xx, xx). 
Please restart 
NovoCyte and 
NovoExpress.

USB cable between 
the NovoCyte 
instrument and 
workstation is not 
connected properly

►► Reconnect the USB cable between 
the NovoCyte instrument and the 
workstation. 

►► Restart the instrument and NovoEx-
press software.

►► Contact ACEA technical support if 
the error persists.

■

Table 5-2 NovoExpress Prompted Error Messages and Message IDs
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Appendix A	 Accessories and Consumables

To order spare parts and consumables for NovoSampler Pro:

►► Within US, call 1-866-308-2232 or visit www.aceabio.com.

►► Within China, call 400-600-1063 or visit www.aceabio.com.cn.

►► �Users in other countries or regions, please contact your local ACEA Biosci-
ences distributors.

For a complete list of distributors, please visit www.aceabio.com (USA), www.
aceabio.com.cn (China).

Name Product No.

NovoSampler Pro 2020070

NovoSampler 24 Tube Rack 2020079

NovoSampler Pro Connection Cable 2020078

■

http://www.aceabio.com
http://www.aceabio.com.cn
http://www.aceabio.com.cn
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Appendix B	 Technical Specifications

Physical parameters NovoSampler Pro Dimension (W × D × H) : 14.6 × 10.2 × 
11.0 in (37 × 26 × 28 cm)

NovoSampler Pro Weight: 19.8 lb (9 kg) 

NovoCyte Flow Cytometer with NovoSampler Pro installed:
Work space requirements (W × D × H) : 186 × 80 × 80 cm

Operating temperature: 15 °C ~ 32 °C 

Operating Humidity: < 80% and non-condensing 

Power requirements: 100 ~ 220 VAC, 47 ~ 63 Hz, ≤ 20 W

Sample Analysis Compatibility: Compatible with standard 96-well plates 
(flat-bottom, U-bottom, V-bottom), standard 24-well, 48-well 
plates, and NovoSampler 24 tube rack for 12 × 75 mm tubes 

Carryover rate: less than 0.1% (with one rinse cycle per well) 

Mix mode: orbital shaker 

Rinse: automatically rinse the sample injection probe and 
fluidic tubing. 

Minimum sample volume: 90 µL for 96-well plates 

Dead volume: 50 µL for 96-well plates

Workstation Operating System: Microsoft Windows®

Software: NovoExpress

■
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